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Legal information 
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Introduction 1
 

These instructions contain all the information you need for using the device.   

The instructions are aimed at persons mechanically installing the device, connecting it 
electrically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers. 

 

Note 

It is the responsibility of the customer that the instructions and directions provided in the 
operating instructions are read, understood, and followed by the relevant personnel before 
installing the device. 

 

 

1.1 Items supplied 
 
 SITRANS FUS080 transmitter  
 Wall/pipe mounting kit with bracket and terminal 

box 
 SITRANS F US literature CD 
 Transducer coaxial cables 
 Application label 
 SONOKIT installation kit (not shown) 
 Operating Instructions 

Operating In
stru

ctions 

 
 

 

Note 

The scope of delivery may vary, depending on version and add-ons. The contents list in the 
package lists all included parts. 

 

 

Inspection   
Before installing the flowmeter check the following: 

1. Check for mechanical damage due to possible improper handling during shipment. All 
claims for damage are to be made promptly to the shipper. 

2. Make sure the scope of delivery and the information on the nameplates correspond to the 
ordering information. 
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Identification   
The FUS080 transmitter is delivered with two different labels. The transmitter nameplate 
(silver) is placed on the front of the transmitter. The system nameplate (white) is placed on 
the right side of the transmitter. Both labels provide valuable information about the device 
and system. 

In the following the system nameplate is described. 

 
① System number (order code identifying selected options and system serial number) 
② Transmitter production code and serial number  
③ Dimension (nominal size ordered) 
④ Maximum flow value 

Nominal flow value 
Minimum flow value  

⑤ Pulse value (output A) 
⑥ Pulse width (output A) 
⑦ Cable length (one transducer cable) 
⑧ Calibration factor 
⑨ Production year 

Figure 1-1 Example of system nameplate 
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Application label 
The application label is supplied with the device and can be used to show the local 
application settings of the transmitter. It is recommended to fill in this label with the 
application values and place it on the left side of transmitter. 

 
Figure 1-2 Application label 

1.2 History 
The contents of these instructions are regularly reviewed and corrections are included in 
subsequent editions. We welcome all suggestions for improvement.   

The following table shows the most important changes in the documentation compared to 
each previous edition. 

 

 
Edition Remarks FW version EDD version   
07/2012 First edition 2.03 01-02-07 

The documentation of this edition is applicable for the firmware stated in the table.   
 

Note 

A flowmeter system consists of a sensor retrofit kit (SONOKIT) and a transmitter (FUS080). 

These Operating Instructions only cover the transmitter part of the system. The sensor part 
has a separate manual, which is available on the SITRANS F US literature CD-ROM and on 
the flowdocumentation website (http://www.siemens.com/flowdocumentation) 

 

 

http://www.siemens.com/flowdocumentation


Introduction  
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1.3 Further Information 

Product information on the Internet    
The Operating Instructions are available on the CD-ROM shipped with the device, and on 
the Internet on the Siemens homepage, where further information on the range of SITRANS 
F flowmeters may also be found: 

Product information on the internet (http://www.siemens.com/flow)  

Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact 
information for your local contact person on the Internet: 

Local contact person (http://www.automation.siemens.com/partner)  

http://www.siemens.com/flow
http://www.automation.siemens.com/partner
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Safety notes 2
 
 

CAUTION  
Correct, reliable operation of the product requires proper transport, storage, positioning and 
assembly as well as careful operation and maintenance. Only qualified personnel should 
install or operate this instrument.   

 

 Note 

Alterations to the product, including opening or improper modifications of the product, are not 
permitted. 

If this requirement is not observed, the CE mark and the manufacturer's warranty will expire.
 

2.1 Laws and directives 

General requirements    
Installation of the equipment must comply with national regulations. For example EN 60079-
14 for the European Community. 

Instrument safety standards   
The device has been tested at the factory, based on the safety requirements. In order to 
maintain this condition over the expected life of the device, the requirements described in 
these Operating Instructions must be observed. 

 

NOTICE  
Material compatibility   

Siemens Flow Instruments can provide assistance with the selection of wetted sensor 
parts. However, the full responsibility for the selection rests with the customer and Siemens 
Flow Instruments can take no responsibility for any failure due to material incompatibility. 

 



Safety notes  
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CE-marked equipment 
The CE mark symbolizes the compliance of the device with the following guidelines: 

● EMC guideline 89/336/EWG 

● Low voltage guideline 73/23/EWG 

● Pressure equipment directive (PED/DGRL) 93/23/EG 

2.2 Lithium batteries 
Lithium batteries are primary power sources with high energy content designed to represent 
the highest possible degree of safety.  

 

WARNING  
Potential hazard 

Lithium batteries may present a potential hazard if they are abused electrically or 
mechanically. This is in most circumstances associated with the generation of excessive 
heat where internal pressure may cause the cell to rupture.  

Thus the following basic precautions should be observed when handling and using lithium 
batteries: 
 Do not short-circuit, recharge or connect with false polarity. 
 Do not expose to temperature beyond the specified temperature range or incinerate the 

battery. 
 Do not crush, puncture or open cells or disassemble battery packs. 
 Do not weld or solder to the battery’s body. 
 Do not expose contents to water. 

 

2.3 Installation in hazardous area 
 

WARNING  
NOT allowed for use in hazardous areas! 

Equipment used in hazardous areas must be Ex-approved and marked accordingly!    

This device is NOT approved for use in hazardous areas! 
 



 Safety notes 
 2.4 Certificates 

SITRANS FUS080 transmitter 

Operating Instructions, 07/2012, A5E03059912-02 13 

2.4 Certificates 
Certificates are posted on the Internet and on the documentation CD-ROM shipped with the 
device. 

See also 
Certificates (http://www.siemens.com/processinstrumentation/certificates) 

http://www.siemens.com/processinstrumentation/certificates


Safety notes  
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3Description 

 

SITRANS F US ultrasonic flowmeters measure flow in standard volumetric units. The 
measurement is independent of changes in liquid temperature, density, pressure and 
conductivity. The flowmeter is designed for use on single phase liquids.   

They are designed for measurement of: 

● Volume flow rate 

● Bidirectional flow measurement 

● Total volume 

The specific calibration for the SONOKIT pipe installation is done by carefully measuring the 
sensor geometry and manual programming of mechanical/geometrical pipe data via the 
software tool SIMATIC PDM* in the transmitter. 
*PDM: Process Device Manager (software programing tool) 

Main applications 
The main application for flowmeters with the transmitter SITRANS FUS080 is measurement 
of water flow in district heating plants, local networks, boiler stations, substations, chiller 
plants, irrigations plants, and other general water applications. 

3.1 System components 
The 1-path or 2-path ultrasonic flowmeter system SITRANS F US SONOKIT with transmitter 
SITRANS FUS080 includes: 

● Battery or mains-powered transmitter (type SITRANS FUS080) 

● Sensor retrofitting set type SITRANS F US SONOKIT (1-path for pipe diameters from DN 
100 (4") up to DN 1200 (48") or for 2-path from DN 200 (8") up to DN 1200 (48")) 

● MODBUS RTU (RS 485 or RS 232) optional communication module (to be mounted into 
the wall mounting kit) 

 
Figure 3-1 SITRANS FUS080 with SONOKIT mounting parts 



Description  
3.2 Design 

 SITRANS FUS080 transmitter 

16 Operating Instructions, 07/2012, A5E03059912-02 

 

Communication solutions 
The transmitter supports MODBUS RTU communication via the optical IrDA interface at the 
display, enabling the change of different transmitter settings using the SIMATIC PDM 
software tool. 

The transmitter provides two pulse outputs for volume pulses or alarm. Optionally, a 
MODBUS RTU communication module (RS 485 or RS 232) can be installed to enable 
communication directly between a PLC/RTU and the transmitter. 

3.2 Design 
The SITRANS FUS080 transmitter is designed with fiberglass reinforced polyamide 
enclosure for remote or compact installation. The remote versions are available with up to 30 
meter distance from flowmeter to transmitter. When ordering as a compact version in the 
series FUS380 and FUE380 the transducer cables are pre-mounted at the sensor. 

 
 

 
SITRANS FUS080 transmitter 

 

 
SITRANS FUS080 Display 

The transmitter is available in an IP67 (NEMA 4X/6) enclosure and is designed for use in the 
flowmeters series: 

● SONOKIT (1-path or 2-path) 

● FUS380 (2-path) 

● FUE380 (2-path) 

3.3 Features 
The following features are available:   

● Battery or mains-powered 

● Battery-powered with 3.6 V Lithium dual D-cell batteries 

● Suitable for pipe diameters from DN 100 (4") up to DN 1200 (48") (SONOKIT 1-path) or 
DN 200 (8") up to DN 1200 (48") (SONOKIT 2-path) 

● IP67 (NEMA 4X/6) rated polyamid enclosure 



 Description 
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● Factory preset to the nominal dimensions of pipe type and pipe size 

● Manual programming of mechanical/geometrical pipe data via SIMATIC PDM 

● Local control panel with single push button, 8-digit display and IrDA optical interface for 
communication with SIMATIC PDM 

● Display showing accumulated volume as well as instantaneous flow rate. The displayed 
units are m3/h and m3 

● Two digital outputs for volume pulse or alarm 

● Optional field bus communication module (MODBUS RTU) for direct communication with 
a PLC/RTU. Recommended use of such options are with mains-powered versions. 

3.4 Principle of operation 

Physical principle   

 
Figure 3-2 Velocity distribution along sound path 

A sound wave travelling in the same direction as the liquid flow arrives at point B from point 
A in a shorter time than the sound wave travelling against the direction of flow (from point B 
to A). 

The difference in sound transit time indicates the flow velocity in the pipe. 

Since delay time is measured at short intervals both in and against flow direction, 
temperature has no influence on measurement accuracy. 

SITRANS F US flowmeters 
In SITRANS F US flowmeters the ultrasonic transducers are placed at an angle θ in relation 
to the pipe axis. The transducers function as transmitters and receivers of the ultrasonic 
signals. Measurement is performed by determining the time the ultrasonic signal takes to 
travel with and against the flow. The principle can be expressed as follows: 

v = K × (tB,A – tA,B) / (tA,B × tB,A) = K × Δt/t² 
where 
v = Average flow velocity 
t = Transit time 
K = Proportional flow factor     
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This measuring principle offers the advantage that it is independent of variations in the actual 
sound velocity of the liquid, i.e. independent of the temperature. 

The proportional flow factor K is determined by wet calibration or calculated by "Auto" in 
case of manual programming of mechanical/geometrical pipe data (SONOKIT only). The 
transducer angle (θ), distance between sensors (L) and pipe dimension (Di and Du) are 
shown in the figure below.  

1A

1B

 
Figure 3-3 Measuring principle 

The ultrasonic signal is sent directly between the transducers. The advantage gained 
sending signals from point to point is an extremely good signal strength. 
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4Installing/Mounting 

 

SITRANS F flowmeters are suitable for indoor and outdoor installations.   

● The SITRANS FUS080 has the following temperature specifications: 

– Ambient temperature: -5 to +60 °C (23 to 140 °F) 

● The enclosure rating is IP67 (NEMA 4X/6) or better. 

NOTICE  

 
Make sure that the pressure and temperature specifications indicated on the device 
nameplate/label will not be exceeded.     

NOTICE  
 

Direct sunlight 

Do not expose the device to direct sunlight! 

4.1 Installing FUS080 
 

Note  
Sensor installation 

It is required that the sensor has been installed according to the relevant operating 
instructions and that the sensor measurement report has been completed! 

 



Installing/Mounting  
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1. Mount wall/pipe mounting bracket in an appropriate place 
 

 

 

 
Pipe mounting 

Wall mounting    

 

 

Note  

Take coaxial cable length into consideration, and allow adequate space for cable inlets 
underneath and on both sides. 
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5Connecting 

 

This chapter describes how to wire up the device using the following steps: 

1. Wiring the transducer cables (Page 22) 

2. Wiring the power supply and the output (Page 22) 

Note   

Connection of the transducers to the SONOKIT is described in the separate sensor 
operating instructions. 

Safety measurements 
 

WARNING  
Only qualified personnel may carry out work on the electrical connections. 

 

WARNING  
Danger of electric shock! 

Never install the device with the mains voltage switched on! 
 

Cable specifications    
● The line length from the cable gland to the terminals must be kept as short as possible. 

Line loops in the terminal box must be avoided. 

● Lay heat-resistant transducer cables if high temperatures can occur on the housing, e.g. 
due to conduction of heat by the sensor/metering tube. Lay the cables so that they do not 
come into contact with the hot sensor/metering tube. 

● Lay signal and transducer cables separately from cables with voltages > 60 V.  

● To guarantee the IP67 (NEMA 4X/6) degree of protection, use cables with the required 
specifications 
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Note   

Transmitter grounding 

To ensure identical potential for sensor and transmitter, a direct grounding of transmitter 
and sensor is recommended. 

WARNING  
 

Protective conductor terminal    

The required cable is min. AGW16 or 1.5 Cu. 

WARNING  
 

Wire insulation   

The insulation between the connected mains supply and the low voltage supply for the 
flowmeter must be rated with at least double or reinforced insulation at mains voltage. 

For field wiring installation: Ensure that the National Installation Code of the country in 
which the flowmeters are installed is met. 

5.1 Wiring the transducer cables 
The system SONOKIT with FUS080 transmitter is supplied with separate transducer coaxial 
cables:  

● 2 cables for 1-path 

and  

● 4 cables for 2-path 

The cables can be used on all transducers (cables are not paired with a specific transducer). 

The cables are manufactured with crimp on the cable ends for the connection board. 
 

Note 

If the cables are shortened, all cables must be shortened equally, and the factory set cable 
length must be changed accordingly in the transmitter. 

 

 



 Connecting 
 5.1 Wiring the transducer cables 

SITRANS FUS080 transmitter 

Operating Instructions, 07/2012, A5E03059912-02 23 

Connecting the cables to the wall/pipe mounting kit 
1. Snap out connection plate and loosen grounding wire. 

 

 
2. Smoothly push cables one by one from underneath base through glands and adjust all 

cable ends approximately 100 mm from upper frame of base.  
 

 

 
Figure 5-1 Electrical connection to SONOKIT 1-path 
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Figure 5-2 Electrical connection to SONOKIT 2-path 

  Note 

Ensure that the right cable entries are used. 
 1-path: 

– Terminal 1A is connected to transducer 1A 
– Terminal 1B is connected to transducer 1B 

 2-path: 
As 1-path and additionally: 
– Terminal 2A is connected to transducer 2A 
– Terminal 2B is connected to transducer 2B 

  Note 

For sensor (transducer) connection, see SONOKIT 1-path or SONOKIT 2-path Operating 
Instructions. 

3. Remount connection board in wall/pipe mounting kit. 
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4. Ground transmitter via grounding terminal (PE) on PCB. 
 

Note   

Sensor grounding 

To ensure identical potential for sensor and transmitter, a direct grounding of transmitter 
and sensor is recommended. 

5. Tighten both transducer cable glands. 
 

 
6. Make sure that transducer cables are not overbent. Minimum cable bend radius is 50 

mm. 
 

 

5.2 Wiring the power supply and the output 
The wiring of the power supply and the output is done in three steps: 

1. Wiring the power supply 

2. Wiring the pulse output (if relevant) 

3. Mounting the transmitter 

5.2.1 Wiring the power supply 
 

WARNING  
Make sure the power supply requirements stated on the nameplates are met! 

 



Connecting  
5.2 Wiring the power supply and the output 

 SITRANS FUS080 transmitter 

26 Operating Instructions, 07/2012, A5E03059912-02 

The transmitter is available in three versions: 

● Battery-powered only 

● Mains-powered 

● Mains-powered with battery back-up 

Determine the transmitter power source type by reading the nameplate or via the product 
code. 

 

 Note 
Change of power source 

The specified type of power supply cannot be altered. E.g. a battery-powered transmitter 
cannot be upgraded with additional mains power. 
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1. Wire battery (battery-powered versions only). 
 

 
Figure 5-3 Wiring the battery 

2. Connect power supply to L1, N and protective earth (PE) (mains-powered versions only). 
 

 
Figure 5-4 Power supply and output connection 

NOTICE  
 

Cable straps 

It is recommended to use cable straps. 

3. Fix power supply cable to terminal housing with clamp (mains-powered versions only). 
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5.2.2 Wiring the pulse output 
 

CAUTION  
Pulse output 

The pulse output must be connected to equipment complying with Low Voltage Directive in 
order to be considered safe. The isolation within the FUS080 pulse output is only a 
functional isolation. 

 

1. Prepare cable ends as shown above. 

2. Connect output cables to terminals 56 and 57 (Output A) and to 66 and 67 (Output B) 
according to use. The output functions are used as shown above. 

3. Ground cable shielding by fixing it with clamp. 
 

CAUTION  

 
EMC performance 

Incorrect fixing of the cable shield will affect the EMC performance! 

5.2.3 Mounting the transmitter 
1. Tighten power supply and pulse output cable glands. 

2. Mount transmitter. 
 

 
Figure 5-5 Mounting the transmitter on terminal box 
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Commissioning 6
 

Commissioning the device includes the following steps: 

1. Resetting the battery lifetime ("Start-up routine" (Page 31)). 

2. Configuring the device via SIMATIC PDM ("Commissioning via PDM" (Page 32)). 

Before commissioning, a basic guide to the local display and the menu structure is offered in 
the chapters: 

"Operating the local display" 

"Navigating the menu structure" 

6.1 Operating the local display 
The local display is divided into 3 areas:   

● Top area with symbols for status information 

● Mid area with actual readings 

● Lower area with index number of the shown menu 

Activate the push button to go the next index menu and related information. 

 
Operating the local display 

Table 6- 1 Information symbols 

Symbol Description 

 Mains power supply connected 

 Battery charge status 

 Warning 

 



Commissioning  
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Battery status 
There are two symbols for battery charge status: 

● "Battery full" indicates battery charge above the warning level (6-year hour counter). 

● "Battery low" indicates battery charge below the warning level and that the battery should 
be replaced. 

Note   

"Battery low" only indicates that battery charge is below a pre-set level, not that charge is 
zero. Flow measurement continues uninterrupted until the battery is completely drained. 

Table 6- 2 Information symbols 

Symbol Description 

 Battery status, full 

 Battery status, low 

 
 

 

Note  
Change of settings and parameters 

The measured values are shown on the local display. Display settings as for example hiding 
specific menus cannot be changed via the local display. 
 Access and change display settings, set parameters, and locate and diagnose failures via 

the IrDA optical interface and SIMATIC PDM. 
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6.2 Navigating the menu structure 
Use the push button to navigate between the following menu items: 

Table 6- 3 Menu items   

Menu Parameter Display example Comments 
Menu 1 Flow volume totalizer 1 

 

Factory preset is forward 
volume flow. 
The battery symbol shows 
full. 

Menu 2 Flow volume totalizer 2 

 

Factory preset for reverse 
flow. 
Negative values indicate 
reverse flow calculation. 

Menu 3 Actual flow rate 

 

Negative values indicate 
reverse flow calculation.. 

Menu 4 Alarm codes 

 

Each code refers to a 
specific alarm. 

Menu 5 Display test 

 

Check of all segments. 
Display toggles between all 
segments on/off. 

6.3 Start-up routine 
1. Power-up device. 

2. Reset battery status indicator as described below (battery-powered versions only). 

Resetting the battery counter   
 

Note  

The reset can also be carried out via SIMATIC PDM. 
 

When new batteries are installed and the plug is connected, the transmitter start-up routine 
begins. The display shows the active software version, e.g. 2.03. 

After ten seconds the message "reset.bat" will appear. 
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1. Press push button within six seconds to reset the internal battery counter. The message 
"accept" will appear. 

2. Press push button again within six seconds in order to reset the internal battery counter.  
The battery indicator now shows full. If the push button is not pressed again, the battery 
indicator will show "Low". 

 
Figure 6-1 Reset internal battery counter 

* Software version 

6.4 Commissioning via PDM 
SIMATIC PDM (Process Device Manager) is a software package for configuring, 
parameterizing, commissioning, and maintaining field devices (e.g. transducers).    

Among other features, SIMATIC PDM contains a simple process for monitoring process 
values, interrupts and status/diagnosis signals of a field device. 

 

Note 

For instructions on installation and operation of SIMATIC PDM, refer to the SIMATIC PDM 
Getting Started (included in the documentation package that comes with PDM). 

 

 

 

 Note 

Minimum PDM version required is SIMATIC PDM V6.0 + SP5 
 

 Note 
Default password 

Any data changes in PDM requires a password. The default password is 1000. For further 
information, see "Password-protected data" (Page 46). 

 

In the following it is described how the device is commissioned using SIMATC PDM. 
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The commissioning is divided into the following steps: 

1. Installing and connecting in the IrdA interface adapter 

2. Installing the device driver (Page 34) 

3. Adding the device to the network (Page 34) 

4. Configuring the device (Page 34) 

5. Optimizing the system (Page 40) 

6. Checking the operation readiness (Page 41) 

6.4.1 Installing and connecting the IrDA interface adapter 
 

Note  
IrDA driver installation 

For installation of the IrDA driver, refer to the instructions delivered with the adapter. 
 

1. Connect IrDA adapter to PC 
 

 
2. Mount adapter on FUS080 

When the IrDA adapter is connected correctly, a small icon appears on the taskbar of your 
PC. When the mouse is placed on this icon, the device information will be shown (e.g. 
"FUS080 SN1033 is in range"). 
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6.4.2 Installing the device driver 
Install the PDM device driver as follows:    

1. Download update from the Internet on SITRANS F US downloads 
(http://support.automation.siemens.com/WW/view/en/16889017/133100), or copy it from 
supplied CD into envisaged folder and unzip the file. Check that the EDD is the version 
valid for the device. 

2. Open "Manage Device Catalog" from Start → SIMATIC → SIMATIC PDM. 

3. Navigate to PDM device driver, select device and click "OK". The driver is installed on the 
PC. 

6.4.3 Adding the device to the network 
It is recommended to configure the FUS080 project in PDM before setting the parameters.  

1. Add device to SIMATIC MODBUS network: 

– Select "File" → "New" 
Type in a project name, e.g. SONOKIT 

– Right click on "Net" and select "Insert New Object" → "Modbus Net". 
Your PC is now added to the Modbus Net 

– Right click on "Modbus Net" and select "Insert New Object" → "Modbus Device" 

– Click on "Assign" and assign the Modbus device to SITRANS FUS/E080 (Sensors → 
Flow → Ultrasonic → SIEMENS AG → SITRANS FUS/E080) and click "OK". 
Rename device according to application requirements (max. 32 characters). 
Set up communication parameters for SIMATIC MODBUS network 

– Select "Net" → "Modbus Net", right click on "Modbus net" and select "Object 
Properties" 

– Select "Connection" to activate IrDA 

6.4.4 Configuring the device 
In the following it is described how to configure the device by defining all sensor specific 
parameters. 

 

 Note 
Measurement accuracy 

A correct sensor installation and a completed measurement report containing correctly 
defined sensor-specific data is required to ensure optimum measurement accuracy. 
 For further information, refer to the sensor operating instructions. 
 For allowed inaccuracies, refer to "Sensor geometrical data" (Page 63). 

 

http://support.automation.siemens.com/WW/view/en/16889017/133100
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Read all parameters 
Before any parameterization is done it is necessary to read all parameters from the device 
into the offline table of SIMATIC PDM. The offline table merely contains default data. 

1. Open PDM device driver. 

2. Select "Upload to PC/PG .." Select "Execute even if the device TAG does not match the 
project data TAG.", and click "OK" to read all parameters to the offline table.  
After closing the dialog box, all loaded parameters should show "Loaded" in the status of 
the PDM table. For a complete parameter list, see "Parameter list" (Page 69). 

3. Store factory set default values on your local PC ("File" → "Export") in order to be able to 
retrieve default settings. 

Read, write device data 
Only parameters (data) shown with white background can be changed. 

 

 Note 
Status field 
 "Changed" indicates off-line data not yet stored in the device. 
 "Loaded" indicates actual device data. 
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To view possible settings, right-click and select "Help". 

For overview of the parameters see "Parameter list" (Page 69). 
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Set sensor-related parameters 
1. Select "Device"→"Pipe geometric assistant" in order to calculate: 

– Rn for path 1 and 2 (pipe constant in line 304 and 305) 

– Calibration Factor (Flow-Profile-Factor for retrofit, line 310) 

– Diameter (line 306) 

2. Define sensor-specific parameters based on data from the sensor measurement report 
and the selection made at ordering: 

– Select metric (m, m/s) or imperial (in, ft/s) units for data entry. Internal calculation in 
the device is made in metric units only. 

– Enter outer pipe diameter (Du) and average pipe wall thickness (t). 

– Flow velocity (V) is automatically calculated using entered pipe data and given Qmax 
(PDM parameter row 10). 

– Enter media viscosity in cSt (e.g. 1 cSt for water at 20 °C). 

– Enter the pipe roughness value. 
The pipe-roughness default value is automatically set according to pipe material or 
can be entered manually by selecting "User defined" (range: 0.0000 to 0.0100 m). 

 

Pipe material Typical roughness 
Smooth plastic pipe (select PVC) 0.0001 m 
Polished stainless steel pipe 0.0001 m 
Standard carbon steel pipe (select STEEL) 0.0004 m 
Rusty carbon steel pipe 0.001 ... 0.002 m 
Concrete pipe (Select CONCRETE) 0.002 ... 0.005 m 
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3. Depending on the SONOKIT type (1-path or 2-path), enter additional sensor data: 

 

Parameter 1-path 2-path 
Number of paths 1 2 
Outer pipe diameter DU DU 
Pipe wall thickness  t t 
Average path distance* H H 
Path 1 angle A1 A1 
Path 2 angle - A2 
Average transducer 1 distance L1 L1 
Average transducer 2 distance - L2 
Velocity (auto calculated with Qmax) V V 

* For crossed paths solutions with no path displacement: Enter "0". 

 
Figure 6-2 1-path sensor data 
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Figure 6-3 2-path sensor data 

4. Click on "Apply pipe geometric settings" and then on "OK" to transfer the data into 
appropriate "Value" and "Unit" cells. Values are transferred and shown in metric units 
only. Close the pipe geometric tool dialog box by clicking on "OK". Click "OK" to confirm 
the data entered. 

 
Figure 6-4 Changed values successfully transferred 
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Clicking on "Apply pipe geometric settings" will initiate automatic calculation of the following: 

● Rn for path 1 and path 2 

● Cal. factor 

For further information, see: 

Dimension dependent settings, SONOKIT 2-path (Page 86) or SONOKIT 1-path (Page 89). 

Measurement report, SONOKIT 2-path (Page 85) or SONOKIT 1-path (Page 88). 

6.4.5 Optimizing the system 
After defining the sensor-specific parameters, additional parameters can be set according to 
use. 

The following shows how to set Pulse Output A and Qmax.  

For other parameters, refer to "Parameter lists (Page 69). 

Setting Pulse Output and Maximum Flow (Qmax) 
1. Navigate to menu "Device" → "Pulse guide" 

The "guide" calculates the pulse-frequency at the max flow condition and tells you how 
close you are on over-speeding the pulse-output.  
The volume per pulse is freely scalable from 0.000001 to 10000 units per pulse. It also 
calculates the minimum volume per pulse you can choose to avoid pulse over-speeding.  
The maximum output frequency depends on the pulse selected; e.g. maximum output 
frequency at 5 ms is 100 Hz. Increasing the pulse width lowers the maximum output 
frequency. 

2. Select maximum flow rate (never to be exceeded). 

3. Select an appropriate pulse width, e.g. 5 ms. 

4. Enter a value in "Amount per pulse A", e.g. 100, to define the volume/pulse with respect 
to the "Minimum amount per pulse value". 

5. Press "Apply Change of Pulse" to apply the settings. 

6. If needed, proceed with setting Pulse Output B according to application specific 
requirements (Default setting = Alarm). 
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6.4.6 Checking the operation readiness 
All parameters are now set and defined according to the application. 

1. Select: "Device" → "Download to device..." to download the parameters to the device. 

 Note  

Before downloading the parameters, check that all listed data are loaded or changed and 
in accordance with the application requirements. 

2. Select "Execute even if the device TAG does not match the project data TAG." and click 
"OK" to download all changes from the table to the device. 

View process values   
The system is now ready for normal operation.  

1. Select "View" → "Display" to see all measured process values. 

2. Verify that the fields show the expected values. 
 

 

  
 

 

 Note 
Measured Track Values 

The "Measured Track Values" should show stable values within the normal range, i.e. the 
gains should be stable values between 3 and 12 (smaller sizes low values and larger sizes 
high values) and the actual velocities for the paths should be stable, constant and smoothly 
changing values between 0 and 10 m/s. 
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Store settings on the PC 
Store the device settings after verifying the values.  

● Choose: "Read" → "Upload to PC" to get all the settings. 

● Store the complete settings on your PC via "File" → "Export". 

6.4.7 Qualification certificate 
For your convenience you may create a qualification cerfíticate (Page 65)  

1. Click on "Device" → "Qualification Certificate". 
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2. Click on "Generate qualification certificate". 

 
3. Click on "Close". 

 
The Qualification Certificate is now available via Microsoft Word. 





 

SITRANS FUS080 transmitter 

Operating Instructions, 07/2012, A5E03059912-02 45 

Functions 7
7.1 Unit selection 

The device is delivered with totalizer and flow rate units in m and m3/h, respectively, as 
standard. However, it is possible to manually configure the device to operate with other units. 

Changing the units 
Go via PDM menu "Device" → "Unit guide". Select the new unit from the list and click on 
"Apply Change of Units". The change should be stored into the transmitter via "Device" → 
"Download to Device" afterwards. 

 
Figure 7-1 Unit selection 

 

Note  

The display is only able to show m3 and m3/h 
 

If the units are changed to units other than m3 and m3/h, the display will not show any unit 
indication after the measured value on the display. To show the new customer unit on the 
display, a sticker can be used to show units. This sticker should be affixed to the transmitter 
display. 

7.2 Number of decimal digits 
For the display values (totalizers in menu 1 and 2 and flow in menu 3) "Auto adjust decimal 
point" is the default setting. This means that the number of digits after the decimal point 
automatically will be reduced with increasing number of digits before the decimal point. 
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7.3 Password-protected data 
In the MODBUS communication via SIMATIC PDM, the flowmeter information is protected 
by a password. The default password is "1000" and it can be changed after gaining access 
to the flowmeter or via the PDM menu "Device" → "Change Password". The password can be 
changed without the use of the HW key. 

 
Figure 7-2 Change password 

Click "Write new password to the device" and "Close" 
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7.4 Hardware key 

HW key 
To gain access to protected parameters of the transmitter, a hard-ware jumper (HW key) 
must be installed as shown below. The HW key place is located internally on the right top 
part of PCB behind the display as shown. 

 
Figure 7-3 HW key behind the display (pins to the right) 

 Note 
Important 

In this mode, with the HW key installed, many parameters in PDM are opened. If these 
parameters are changed, it can seriously affect the meter accuracy and operation. Be careful 
when writing new parameters. 

Changing the HW-protected parameters 
1. Disconnect power supply to transmitter, i.e. battery plug and/or the mains power supply 

2. Remove frame and display from transmitter. 

3. Insert HW key as shown in figure above. 

4. Remount display and frame on transmitter. 

5. Restart device. 

6. Make parameter changes via PDM. 

7. Download parameter changes to device. 

8. Remove HW key by following the steps above. 



Functions  
7.4 Hardware key 

 SITRANS FUS080 transmitter 

48 Operating Instructions, 07/2012, A5E03059912-02 



 

SITRANS FUS080 transmitter 

Operating Instructions, 07/2012, A5E03059912-02 49 

Service and maintenance 8
8.1 Maintenance 

The device is maintenance-free. However, a periodic inspection according to pertinent 
directives and regulations must be carried out.   

An inspection can include check of: 

● Ambient conditions 

● Seal integrity of the process connections, cable entries, and cover screws 

● Reliability of power supply, lightning protection, and grounds 

NOTICE  
 

Repair and service must be carried out by Siemens authorized personnel only. 

  Note 

Siemens defines flow sensors as non-repairable products.    

8.2 Battery replacement 
 

NOTICE  
It is recommended to replace the battery pack every 6 years. 

 

 Note 
Battery lifetime 

The battery lifetime depends on the use of the different functions, e.g. the use of MODBUS 
communication will decrease the lifetime significantly, see Technical data" (Page 31)  

For the use of add-on modules with MODBUS communication, the use of mains-powered 
transmitters is recommended. Typical liftetime of a dual battery pack with nominal working 
pulse output frequency of 20 Hz is approximately 4.2 years. 
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1. Unscrew battery cover and remove old battery pack. 
 

 
2. Fit new battery pack in transmitter 
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3. Connect battery.  
Ensure that wire is inserted into small channel leading from plug to battery. 
 

 
4. Remount battery cover. 

 

 

Note 

Every time a battery is fitted and connected, the unit runs a start-up routine. 

A battery replacement does not influence accumulated process values. Accumulated 
values can only be reset using SIMATIC PDM. 
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Resetting the internal battery counter 
After replacing the batteries, reset the internal battery counter (Page 31) in order to indicate 
the power capacity correctly. 

8.3 Technical support 
If you have any technical questions about the device described in these Operating 
Instructions and do not find the right answers, you can contact Technical Support:    

● Via the Internet using the Support Request:  
 Support request (http://www.siemens.com/automation/support-request)  

● Via Phone: 

– Europe: +49 (0)911 895 7222 

– America: +1 423 262 5710 

– Asia-Pacific: +86 10 6475 7575 

Further information about our technical support is available in the Internet at  
Technical support (http://support.automation.siemens.com/WW/view/en/16604318) 

Service & Support on the Internet     
In addition to our documentation, we offer a comprehensive knowledge base online on the 
Internet at:  

Service and support (http://www.siemens.com/automation/service&support)  

There you will find: 

● The latest product information, FAQs, downloads, tips and tricks. 

● Our newsletter, providing you with the latest information about your products. 

● A Knowledge Manager to find the right documents for you. 

● Our bulletin board, where users and specialists share their knowledge worldwide. 

● You can find your local contact partner for Industry Automation and Drives Technologies 
in our partner database. 

● Information about field service, repairs, spare parts and lots more under "Services." 

Additional Support   
Please contact your local Siemens representative and offices if you have additional 
questions about the device 

Find your contact partner at: 

Local contact person (http://www.automation.siemens.com/partner)  

http://www.siemens.com/automation/support-request
http://support.automation.siemens.com/WW/view/en/16604318
http://www.siemens.com/automation/service&support
http://www.automation.siemens.com/partner
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8.4 Application-specific data 
In case the device needs service, the technical support team will typically request 
information about the application and the flowmeter.   

● Prepare a sketch of the installation / application. 

● Prepare a qualification certificate 

– Open SIMATIC PDM. 

– Select "Device" → "Qualification Certificate" and download certificate as a Word file. 

– Fill in required information. 

See example of qualification certificate in "Qualification certificate" (Page 65). 

8.5 Return procedures 
Enclose the delivery note, the cover note for return delivery together with the declaration of 
decontamination form on the outside of the package in a well-fastened clear document 
pouch.    

Required forms 
● Delivery Note 

● Cover Note for Return Delivery with the following information 

Return delivery form (http://support.automation.siemens.com/WW/view/en/16604370) 

– product (ordering number) 

– number of devices or spare parts returned 

– reason for the return 

● Declaration of Decontamination  

Decontamination declaration 
(http://pia.khe.siemens.com/efiles/feldg/files/Service/declaration_of_decontamination_en.
pdf) 

With this declaration you certify that the returned products/spare parts have been 
carefully cleaned and are free from any residues. 
If the device has been operated together with toxic, caustic, flammable or water-
damaging products, clean the device before return by rinsing or neutralizing. Ensure that 
all cavities are free from dangerous substances. Then, double-check the device to ensure 
the cleaning is completed. 

We will not service a device or spare part unless the declaration of decontamination 
confirms proper decontamination of the device or spare part. Shipments without a 
declaration of decontamination will be cleaned professionally at your expense before 
further proceeding.  

http://support.automation.siemens.com/WW/view/en/16604370
http://pia.khe.siemens.com/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
http://pia.khe.siemens.com/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
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You can find the forms on the Internet and on the CD delivered with the device. 
 

 Note 
Return of products with Lithium batteries   

Lithium batteries are certified as dangerous goods according to the Regulation of Dangerous 
Goods, UN 3090 and UN 3091. Special transport documentation is required to observe 
these regulations.  

Therefore it is recommended to remove lithium batteries prior to shipment 

If the battery is important for the examination of the product and it cannot be removed, the 
product has to be returned according to the Regulation of Dangerous goods. 

 

8.6 Battery disposal 
In accordance with EU directive 2006/66/EC, batteries are not to be disposed of using 
municipal waste disposal services. 

Waste industrial batteries are accepted back by Siemens or by the local Siemens 
representative. Please talk to your local Siemens contact 
(http://www.automation.siemens.com/partner) or follow the return procedures (Page 53) of 
Siemens Flow Instruments. 

8.7 Disposal 
 

Devices identified by this symbol may not be disposed of in the 
municipal waste disposal services under observance of the 
Directive 2002/96/EC on waste electronic and electrical 
equipment (WEEE).  

 

They can be returned to the supplier within the EC or to a 
locally approved disposal service. Observe the specific 
regulations valid in your country. 

http://www.automation.siemens.com/partner
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9Troubleshooting/FAQs 

 

In case of an error, the device provides error codes via the display. The error codes are also 
available via SIMATIC PDM. 

Furthermore, in case the device is not measuring correctly, a diagnostic function is available 
via the SIMATIC PDM. 

9.1 Error codes 
A list of errors is available in SIMATIC PDM (active errors are check-marked). Access to this 
list is gained via "Device" → "Device Status". In the figure below, error codes F 1, F 2 and F 5 
are active. 

 
Figure 9-1 List of errors shown in PDM 
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Table 9- 1 Error codes shown in the display and in PDM   

Error 
code 

Error Remedy / Cause 

Blank 
display 

Battery plug not connected, or battery 
empty, mains power interrupted 

 Check flowmeter version. Battery version not 
able to run on mains power 

 Battery empty: Replace battery pack 
 Battery plug not plugged into the transmitter, 

see "Battery replacement" 

F 1 Path 1 (upper path) not measuring No water in upper part of pipe and/or cables or 
transducer 1A or 1B defective 

F 2 Path 2 (lower path) not measuring No water in lower part of pipe and/or cables or 
transducer 2A or 2B defective 

F 3 Internal software failure Contact Siemens customer support 
F 4 Internal software failure Contact Siemens customer support 
F 5  Power supply warning  Mains power fails (only mains-powered 

versions with battery back-up) 
 Replace battery pack (battery-powered 

versions only) 

F 6  Flow exceeds preset flow rate in unit 
(max. speed 10 m/s) 

Flowrate too high 

F 7 Pulse output A overflow Pulse output exceeds 100 Hz or 50% duty cycle 
F 8 Pulse output B overflow Pulse output exceeds 100 Hz or 50% duty cycle 
F 9 Datalogger warning/alarm  Datalogger warning monitors whether actual 

consumption on Totalizer 1 is on end of log 
interval or above/below the limit settings.  
The warning has no influence on the flowmetering. 
Check data logger values and consumption limit 
(via PDM parameter 602)  

Errors "F 1" to "F 4" affect the performance of the meter and the flowmeter may stop 
measuring. 
Errors "F 1" and "F 2" disappear when the alarm condition is corrected. 
Errors "F 5" to "F 9" are only warnings and do not affect the measurement, but they will 
influence the outputs. 
The error indications disappear when the alarm conditions are corrected and a reset via the 
communication interface has been carried out. 

Example 
Error code "F 1 2" in the display indicates a combination of error codes "F 1" and "F 2". 

Possible causes: 

● Empty pipe 

● Path 1 and path 2 cables defective 

● Path 1 and path 2 cables not connected 

● Transducers defective. 
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9.2 Diagnosing with PDM 
SIMATIC PDM is a suitable tool for diagnosing the device. You can use SIMATIC PDM to 
read all parameters available in FUS080 to a table for analyzing offline, view online/actual 
process values and online/actual diagnostic information.   

Requirements 
The following procedure must be completed before diagnosing: 

● Connection of Modbus interface via PC and IrDA, see also "Commissioning via PDM 
(Page 32) 

● Installation of PDM and FUS080 PDM driver, see also "Installing the device driver 
(Page 34) 

Diagnosing with PDM 
Online process values are available under menu "View" → "Display". 

 

  

The "Measured Track Values" tab shows the gain steps and the flow velocities for path 1 and 
path 2. For 1-path applications the values for path 2 (track 2) are "0". 

The gain steps depend on the pipe size and the conditions of the measuring media. 

The flow velocities depend on the flow in the pipe. 
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① Gain step 
② Gain step max 
③ Gain step min 
④ Transducer distance [mm] 

Figure 9-2 SITRANS FU080 Gain step vs. Transducer distance 

Gain step 

The graph above shows which gain step to expect for a particular transducer distance (face 
to face distance). The upper curve indicates the upper limit and the lower curve indicates the 
lower limit.  

The graph applies to perfectly aligned transducers in clean water, but takes into account the 
expected variance from the converter and the transducers.  
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Gain step error conditions 

 
Condition Cause 
15  No transducer (e.g. defective cable) 

 Empty pipe 

High values  High damping (e.g. inhomogeneous media) 
 Unsuitable medium 
 Path angular misalignment 

Unstable/fluctuating values  Air bubbles or solids in medium 
 Bad inlet conditions 

Δ gain step between path 1 and path 2 > 1 
(2-path systems only) 

 Bad inlet conditions 
 Inhomogeneous medium 
 Path angular misalignment 

 

In case of angular misalignment between transducer faces, the gain step will increase as 
shown in the table below: 

 
Angular misalignment Gain step increase 
2° 1 
3° 2 
4° 3 
5° 5 

 

Flow velocity error conditions 

 
Condition Cause 
Δ flow velocity values (between path 1 and path 
2) > 1 
(2-path systems only) 

 Bad inlet conditions (the higher the delta, the 
worse the inlet conditions) 

 Disturbances in the pipe (bad flow profile) 

Unstable/fluctuating values  Air bubbles or solids in media 
 Bad inlet conditions 

 

The actual velocities for the paths should be stable, constant and smoothly changing values 
between 0 and 10 m/s. 



Troubleshooting/FAQs  
9.2 Diagnosing with PDM 

 SITRANS FUS080 transmitter 

60 Operating Instructions, 07/2012, A5E03059912-02 



 

SITRANS FUS080 transmitter 

Operating Instructions, 07/2012, A5E03059912-02 61 

Technical data 10
10.1 SITRANS FUS080 

Table 10- 1 Technical data, FUS080 

Description Specification 
Enclosure design/material  Fiber glass reinforced polyamide in light-gray color 
Enclosure  IP67 according to EN 60529 and DIN 40050 (NEMA 4X/6) 
Wall mounting kit Terminal box made of fiber glass reinforced polyamide in light-gray 

color with 2 + 2 cable glands (output, supply, and transducer 
cables) and a stainless steel bracket for wall or pipe mounting 

Cable glands In wall mounting kit: 
 4 x M20 polyamide cable glands (2 for mains and output 

cables, 2 for the transducer coaxial cables) 

Ambient temperature  -5 °C …+60 °C (23 °F…140 °F) 
Storage temperature  −40 °C…+85 °C (−40 °F…+185 °F)  
Transducer / sensor cables  Coaxial cable, impedance 75 Ohm, ∅ app. 6mm; 

 Cable length: Max. 30 meter between transmitter and 
transducer (factory sets 15 or 30 m (49.21 or 98.43 ft) 

Mechanical vibration  2 g, 1…800 Hz sinusoidal in all directions according to IEC 68-2-6  
Power supply  Battery:  

 Replaceable 3.6 V LiSOCl (Lithium Thionyl Chloride) 
 Double battery pack 32 Ah or single back-up battery 16 Ah; 
 Battery change interval: 6 years at 60 °C (140 °F) operation 

(depending on used functions) 
Mains:  
 87 … 265 V AC (50 … 60 Hz) 

Display   LCD, 8 digits, additional 2 digits and symbols for status 
information 

 Units: 
– Volume unit: m3 (default display unit) 
– Flow unit: m3/h (default display unit) 

 Alarm codes: F 1 to F 9 

Push button  One push button for toggling between display information  
Measuring function   0.5 Hz battery mode 

or  
 15 Hz mains-powered 
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Description Specification 
Communication   IrDA on display panel (MODBUS RTU protocol) 

 Optional: Separate add-on serial communication modules 
MODBUS RTU RS 232 or RS 485 (recommended for 230 V 
versions only) 

Outputs (standard)  Two passive, galvanically isolated open-drain MOS outputs 
(output A and B) 

 Max. ±35 V, 50 mA 
 Output A: Preset to pulse output for forward flow (default: 100 

l/pulse) 
 Output B: Preset to alarm for present failure 
 Pulse width: 5, 10, 20, 50, 100, 200, 500 ms (default: 5 ms) 
 Max. pulse frequency (for 5 ms pulse width): 100 Hz at Qmax 

setting (105% of Qs) 

Output (option)  Fieldbus communication: MODBUS RTU protocol 
 Separate add-on serial communication modules MODBUS 

RTU RS 232 or RS 485 

EMC  Emission EN 61000-6-4  
Immunity EN 61000-6-2  

Transmitter weight  1.5 kg (3 lb)  

10.2 Battery 
 
Battery types 
Replaceable 3.6 V LiSOCl (Lithium Thionyl Chloride) dual battery pack 32 Ah 
Single battery 16 Ah as back-up battery for mains-powered version with back-up battery 

 

 

 Note 

The batteries are not rechargeable; they should be replaced at least every 6 years.   
 

Consumption and battery operation time calculation 

For battery versions, the battery operation time depends on the connected battery pack as 
well as the operation conditions of device.  

Every 5 minutes the advanced power management system of the transmitter calculates the 
battery consumption and the remaining battery operation time. 

For battery versions, only the internal battery pack has a nominal capacity of 33 Ah giving a 
typical operation time of 6 years in a revenue application. 

The ambient temperature of the transmitter its also influence the battery capacity. 
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The typical operation time of 6 years is based on only 80% battery capacity and an operation 
time/temperature profile of 5% at 0 °C (32 °F), 80% at 15 °C (59 °F) and 15% at 50 °C (122 
°F). 

The effect of other temperatures is shown in the figure below. 

A variation in temperature from 15 °C to 55 °C (59 °F to 131 °F) reduces the capacity by 
17% (in the figure from 15 Ah to 12½ Ah). 

 
 

Note  
The installation orientation of the battery pack may influence the battery capacity. Optimal 
battery capacity is achieved with the battery pack in an upright position. 

 

 

10.3 Sensor geometrical data 
In order to ensure maximum measurement accuracy, precise sensor-specific data are 
required. 

 

Data Sensor size Required accuracy 
Path angle DN 100-1200 (8" – 48") 0.1° 

DN 100-400 (8 " – 32") 0.2 mm 
DN 400-1000 (32" – 48") 0.8 mm 

 Transducer and path distances 
 Outer pipe diameter 
 Pipe wall thickness DN 1000-1200 (40" – 48") 2.0 mm 
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Proper use of the measurement report normally ensures that measured values come very 
close to the nominal dimensions listed in the appendix "Settings" "Dimension dependent 
settings", SONOKIT 2-path and "Dimension dependent settings", SONOKIT 1-path  

 

 Note 
Sensor recalibration 

If measured and nominal values differ more than allowed, please re-configure/re-calibrate 
the flowmeter in the field. 

 

10.4 Dimensions 
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Qualification certificate 11
 

 
Figure 11-1 Qualification certificate (page 1) 
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Figure 11-2 Qualification certificate (page 2) 
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Figure 11-3 Qualification certificate (page 3) 
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Parameter lists A
 

The following tables show the various parameters available via PDM. 

The parameters are accessible at three different levels: 

● Read: Maintenance level 

● Read/Write (R/W): Specialist level (write access is only permitted after entering the user 
password; default password is 1000) 

● Hardware locked (HW key): The parameter is only accessible when a HW key is mounted 

A.1 Identification 

Table A- 1 Identification parameters (FW 2.03 and EDD 1.02.07-01)   

Modbus 
Address 

Parameter Default 
value  

Value range Access 
level 

Description 

40049 1 Application identifier Identity  R/W Customer application identification 
information (max 16 characters) 

40057 2 Application location Location  R/W Customer application location 
information (max 16 characters) 

Device 
40032 5 Sensor size Product 

dependent 
See 
"Dimension 
dependent 
settings", 
SONOKIT 2-
path and 
"Dimension 
dependent 
settings", 
SONOKIT 1-
path  

R/W Pipe diameter of the sensor. It is only 
a text field for measurement system 
information. The value has no 
influence on the measurement. Please 
see inner diameter at pipe date in 
parameter 306 

40141 8 Totalizer unit m3 See "unit 
conversion 
table"  

R/W Totalizer unit as text for volume. 
Change the unit in parameter table if 
the device menu 'Unit guide (offline)' 
does not list the wanted unit. 
Note: The device display can show 
'm3' unit only - other units cannot be 
shown on the display, but will be used 
and shown online via PDM 
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Modbus 
Address 

Parameter Default 
value  

Value range Access 
level 

Description 

40135 9 Flowrate unit m3/h see appendix 
A6 

R/W Flow unit as text for actual flowrate. 
Change the unit in parameter table if 
the device menu 'Unit guide (offline)' 
does not list the wanted unit. 
Note: The device display can show 
'm3/s' unit only - other units cannot be 
shown on the display, but will be used 
and shown online via PDM. 

40129 10 Maximum flow Qmax See 
"Dimension 
dependent 
settings", 
SONOKIT 2-
path and 
"Dimension 
dependent 
settings", 
SONOKIT 1-
path 

R/W Maximum flow 

40162 373 Low flow cut-off 0.25 0 ... 10 R/W If the flow comes below this 
percentage of Qmax, then the flow 
value is set to zero 

40008 20 Vendor name Siemens 
A/S 

 Read Siemens A/S Flow Instruments, 
Denmark 

40001 21 Module type 11 0 ... 14 Read Type of flowmeter 
40002 22 Software version 2.03   Software version of the flowmeter 
40022 23 Product code 

number 
Product 
dependent 

  Siemens production sales code 
number (the first part of the system 
number on the nameplate) 

40014 24 System Serial 
number 

Product 
dependent 

 R/W Siemens production number (the s 
econd part of the system number on 
the nameplate 

40065 25 Transmitter serial 
number 

Product 
dependent 

 HW key Serial number of the electronics 

40073 26 Sensor serial number Product 
dependent 

  Serial number of the sensor 

40162 373 Low flow cut-off 0.25 0 ... 10 R/W If the flow comes below this 
percentage of Qmax, then the flow 
value is set to zero 
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A.2 Output 

Table A- 2 Output parameters  

Modbus 
Address 

Parameter Default 
value  

Value range Access 
level 

Description 

43023 100 Actual date and time Product 
dependent

 R/W Actual date and time (day-month-
year and hours:minutes:seconds) 

43006 101 Totalizer 1 0 -2000000001 
... 
+2000000001 

Read Volume for totalization register 1 

43010 102 Totalizer 2 0 -2000000001 
... 
+2000000001 

Read Volume for totalization register 2 

43014 103 Customer totalizer 3 0  Read Customer totalizer 3 based on 
totalizer 1 set up 

19 104 Reset customer totalizer 3 No No, Yes R/W Reset of customer totalizer 
40732 105 Customer totalizer 3 reset 

date 
last reset 
date 

dd-mm-yyyy, 
hh:mm:ss 

 Date and time when customer 
totalizer has been reset 

43001 106 Flow rate   Read Actual flow value 
43136 107 Relative flow rate 0  Read Actual flow value in relation to Qmax
43035 108 Actual velocity for path 1 0  Read The actual flow velocity for path 1 in 

m/s (SI-unit) 
43046 109 Actual velocity for path 2 0   The actual flow velocity for path 2 in 

m/s (SI-unit).  
Valid for 2-path solutions only 

43026 110 Path 1 gain step 15 1 to 15 Read Amplifier setting when measuring 
path 1 

43037 111 Path 2 gain step 15 1 to 15 Read Amplifier setting when measuring 
path 2.  
Valid for 2-path solutions only 

Pulse A B 
40817 430 Output A enable Yes No, Yes R/W Select 'Yes' to enable output A 
40818 431 Pulse A function Forward Forward, 

Reverse, 
Forward net, 
Reverse net 

R/W Pulse output calculation on pure 
forward flow or pure reverse flow - 
or net flow for forward and reverse 
pulse flow.  
Valid if pulse output A is enabled 

40819 432 Amount per pulse A 1.000000 
(m3) 

0.000001 ... 
1000000000 

R/W Volume per pulse and selected unit  
Valid if pulse output A is enabled. 

40821 433 Pulse width for pulse A 5 ms 5, 10, 20, 50, 
100, 200, 500 
ms 

R/W Pulse length when the pulse is 
active.  
Valid if pulse output A is enabled 

40822 440 Output B enable Yes No, Yes R/W Select 'Yes' to enable output B 
40823 441 Pulse B function Alarm Pulse, Alarm, 

Call up 
R/W Configuration of output B as pulse - 

alarm or call up function.  
Valid if pulse output B is enabled 
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Modbus 
Address 

Parameter Default 
value  

Value range Access 
level 

Description 

40824 442 Pulse B direction Reverse Forward, 
Reverse, 
Forward net, 
Reverse net. 

R/W Pulse output calculation on pure 
forward flow or pure reverse flow - 
or net flow for forward and reverse 
pulse flow.  
Valid if pulse output B is enabled 
and pulse function selected 

40825 443 Amount per pulse B 1.000000 
(m3) 

0.000001 ... 
1000000000 

R/W Volume per pulse.  
Valid if pulse output B is enabled 
and pulse function selected 

40827 444 Pulse width for pulse B 5 ms 5, 10, 20, 50, 
100, 200, 500 
ms 

R/W Pulse length when the pulse is 
active.  
Valid if pulse output B is enabled 
and pulse function selected 

Communication 
For editing the communication settings, use PDM device menu "Communication Setting" 
40833 591 Device Communication 

Address 
1 1 ... 247 Read Meter has default address value 1 

with selectable address up to 247 
40834 592 Baudrate 4 0 ... 5 Read Communication port speed 
40835 593 Parity 0 0 ... 3 Read Communication port parity 
40836 594 Interframe space 35 35 ... 255 Read Minimum space between two 

messages (bytes x 10) 
40837 595 Response delay 5 1 ... 50 Read Minimum time from receiving a 

request to its response 
Data logger 
40619 600 Log interval Monthly Daily, Weekly, 

Monthly 
R/W Log interval 

40620 601 Day of week, if weekly log Sunday Monday to 
Sunday 

R/W When log interval is set to weekly 
logging, this parameter defines what 
weekday the logging is performed.  
Valid if weekly log interval is 
activated 

40621 602 Limit for too high 
consumption 

1E+09 -3.4E+38 ... 
+3.4E+38 

R/W Limit for too low consumption during 
current log interval. Based on 
totalizer 1 and the selected unit  

40623 603 Limit for too low 
consumption 

No -3.4E+38 ... 
+3.4E+38 

R/W Limit for too low consumption during 
current log interval. Based on 
totalizer 1 and the selected unit 

22 604 Reset log  No, Yes HW 
key 

Reset data logger 

Periodic log Totalizer 1 
40770 160 Next settling date 01-01-

2000 
dd-mm-yyyy R/W Next settling date where actual 

value of totalizer 1 is stored 
40773 161 Latest settling date 01-01-

2000 
dd-mm-yyyy Read  Latest settling date where value of 

totalizer 1 was stored 
40776 162 Latest totalizer 1 value 0  Read  Latest stored value of totalizer 1 
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Modbus 
Address 

Parameter Default 
value  

Value range Access 
level 

Description 

40780 163 Previous settling date 01-01-
2000 

 Read  Previous settling date where value 
of totalizer 1 was stored 

40783 164 Previous totalizer 1 value 0 dd-mm-yyyy Read  Previously stored value of totalizer 1 

A.3 Diagnostic 

Table A- 3 Diagnostic   

Modbus 
Address 

Parameter Default 
value 

Value 
range   

Access 
level 

Description 

  Diagnostic     
40804 500 Latest service date 01-01-

2000 
dd-mm-
yyyy 

R/W* Latest service date (can also be used 
for date of installation) 

40808 501 Operating hours since 
power up 

0 3.4E+38 h Read Total operation hours since last power 
up 

40807 503 Numbers of power up 0 0 ... 65535 Read Total number of power-ups since first 
power-up. 

Alarm 
43005 200 Fault status  One or 

more of 
the 
following 
values: 1, 
2, 3, 4, ... 
up to 16 

Read Fault status 
1: Path 1 error 
2: Path 2 error 
3: Dual slope calibration error 
4: Database checksum error 
5: Low power warning 
6: Flow overload warning 
7: Pulse A overload warning 
8: Pulse B overload warning 
9: Consumption interval error 
10: Not used 
11: Not used 
12: Not used 
13: Not used 
14: Not used 
15: Not used 
16: Not used 

40346 202 Date of fault log reset Last reset 
date 

dd-mm-
yyyy, 
hh:mm:ss 

Read Date of last fault log reset 

14 204 Reset the fault log and 
faults 

No No, Yes R/W Reset the fault log and faults 

15 205 Call up acknowledge No No, Yes R/W Select 'Yes' to reset active call-up 
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Modbus 
Address 

Parameter Default 
value 

Value 
range   

Access 
level 

Description 

21 209 Reset consumption log 
fault 

No No, Yes R/W Reset the consumption fault.  
Caused by too low or too high 
consumption in the log interval 

3 210 Path 1 alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable current alarm on 
alarm output / call-up 

 211 Path 1 fault hours e.g. 36 h Read;  Total hours fault active 
40258 212 Path 1 fault counter e.g. 4 0 ... 65535 Read Total number of faults.  

Valid only if alarm is enabled 
40259 213 Path 1 fault appears Last fault 

appear 
date 

dd-mm-
yyyy, 
hh:mm:ss 

Read Last time the fault appeared.  
Valid only if alarm is enabled 

40262 214 Path 1 fault disappears Last fault 
disappear 
date 

dd-mm-
yyyy, 
hh:mm:ss 

Read Last time the fault disappeared.  
Valid only if alarm is enabled 

4 215 Path 2 alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up.  
Valid only for 2-path solutions 

40265 216 Path 2 fault hours e.g. 36 h Read; Read Total hours fault active.  
Valid only for 2-path solutions and if 
alarm is enabled 

40266 217 Path 2 fault counter e.g. 4 0 ... 65535 Read Total number of faults.  
Valid only for 2-path solutions and if 
alarm is enabled 

40267 218 Path 2 fault appears Last fault 
appear 
date 

dd-mm-
yyyy, 
hh:mm:ss 

Read First time the fault appeared.  
Valid only for 2-path solutions and if 
alarm is enabled 

40270 219 Path 2 fault disappears Last fault 
disappear 
date 

dd-mm-
yyyy, 
hh:mm:ss 

Read Last time the fault disappeared.  
Valid only for 2-path solutions and if 
alarm is enabled 

5 220 Dual slope alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40273 221 Dual slope fault hours e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40274 222 Dual slope fault counter e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40275 223 Dual slope fault appears e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40278 224 Dual slope fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

6 225 Parameter checksum 
alarm output enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40281 226 Parameter checksum 
fault hours 

e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40282 227 Parameter checksum 
fault counter 

e.g. 0 0 ... 65535 Read Total number of faults. Valid only if 
alarm is enabled 
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Modbus 
Address 

Parameter Default 
value 

Value 
range   

Access 
level 

Description 

40283 228 Parameter checksum 
fault appears 

e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40286 229 Parameter checksum 
fault disappears 

e.g. 0 0 ... 65535 Read Password to change parameters in the 
flowmeter.  
Valid only if alarm is enabled 

7 230 Low power alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40289 231 Low power fault hours e.g. 0 h 0 ... 65535 Read Total hours fault active. 
Valid only if alarm is enabled 

40290 232 Low power fault counter e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40291 233 Low power fault appears e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40294 234 Low power fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

8 235 Flow overflow alarm 
output enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40297 236 Overflow fault hours e.g. 0 h 0 ... 65535 Read Total hours fault active. 
Valid only if alarm is enabled 

40298 237 Overflow fault counter e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40299 238 Overflow fault appears e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40302 239 Overflow fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

9 240 Pulse A overload alarm 
output enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40305 241 Pulse A overload fault 
hours 

e.g. 0 h 0 ... 65535 Read  Total hours fault active.  
Valid only if alarm is enabled 

40306 242 Pulse A overload fault 
counter 

e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40307 243 Pulse A overload fault 
appears 

e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40310 244 Pulse A overload fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

10 245 Pulse B overload alarm 
output enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40313 246 Pulse B overload fault 
hours 

e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40314 247 Pulse B overload fault 
counter 

e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40315 248 Pulse B overload fault 
appears 

e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 
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Modbus 
Address 

Parameter Default 
value 

Value 
range   

Access 
level 

Description 

40318 249 Pulse B overload fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

11 250 Consumption alarm 
output enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40321 251 Consumption fault hours e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40322 252 Consumption fault 
counter 

e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40323 253 Consumption fault 
appears 

e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40326 254 Consumption fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

12* 255 Leakage alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40329 256 Leakage fault hours e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40330 257 Leakage fault counter e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40331 258 Leakage fault appears e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40334 259 Leakage fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

13* 260 Empty pipe alarm output 
enable 

Yes No, Yes R/W Select 'Yes' to enable active alarm on 
alarm output / call-up 

40337 261 Empty pipe fault timer e.g. 0 h 0 ... 65535 Read Total hours fault active.  
Valid only if alarm is enabled 

40338 262 Empty pipe fault counter e.g. 0 0 ... 65535 Read Total number of faults.  
Valid only if alarm is enabled 

40339 263 Empty pipe fault appears e.g. 0 h 0 ... 65535 Read First time the fault appeared.  
Valid only if alarm is enabled 

40342 264 Empty pipe fault 
disappears 

e.g. 0 0 ... 65535 Read Last time the fault disappeared.  
Valid only if alarm is enabled 

Service 
17 510 Fixed flow mode enable Yes No, Yes R/W Select 'Yes' to force the device to show 

a fixed flow value 
Default must be "No" 
Always manually reset the value to 
"No" 

40801 511 Fixed flow value 0 -1E+09 ... 
1E+09 

R/W Fixed flow value for enabled fixed flow  
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Modbus 
Address 

Parameter Default 
value 

Value 
range   

Access 
level 

Description 

40803 515 Controlling output A and 
B 

Auto Auto, 
Forced 

HW key Control of output A and B is used to 
stop or force the output A and/or B. 
For editing, use device menu 'Service'.  
Valid if pulse output is enabled 

Power 
43120 130 Consumed battery 

capacity 
e.g. 
2.054239 
Ah 

 Read The amount of energy consumed since 
last time the battery was replaced.  
Valid only for battery-powered versions 

40808 501 Operating hours since 
power up 

1105 h 3.4 E+38 Read Total operation hours since first power 
up 

40807 503 Numbers of power up e.g. 4 0 ... 65535 Read Total number of power-ups since first 
power-up. 

18 540 Battery change enable No No, Yes R/W Select 'Yes' to set battery installation 
date to current date and reset 
remaining battery operation capacity to 
maximum.  
Valid only for battery-powered versions 

40881 541 Battery installation date last 
battery 
installation 
date 

dd-mm-
yyyy; 
hh:mm:ss 

Read Latest installation date of batteries.  
Valid only for battery-powered versions 

40880 542 Power supply mode Battery 
only 

Battery 
only, 
Mains 
only, 
Mains with 
backup 
battery. 

Read The flowmeter is either powered by 
battery only, mains only or by mains 
with battery backup. 
The type is defined by the order code 
and cannot be changed. 

40849 543 Actual battery capacity 25.000000 0 ... 50 R/W** The capacity of the battery in Ah 
- Single 12.5 Ah 
- Dual battery pack 25.0 Ah 
Valid only for battery-powered versions 

40851 544 Battery alarm limit 80 0 ... 90 R/W Present an alarm when the consumed 
energy superceeds this percentage of 
the battery capacity.  
Valid only for battery-powered versions 

* Not supported for FUS080 
** Maintenance = Read only 
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A.4 Meter setup 

Table A- 4 Meter setup parameters   

Modbus 
Address 

Parameter Default 
value  

Value 
range 

Access 
level 

Description 

Meter Setup 
40179 307 Flow velocity offset 0 m/s -10 ... 10 

m/s 
HW key Velocity added to measured flow 

velocity 
40182 310 Calibration factor 1.0 0 ... 2 R/W This calibration factor will be calculated 

at the factory with wet-calibration. 
For FUS080-SONOKIT (retrofit) 
installations this parameter should be 
calculated by the pipe geometric tool 
(see 'Pipe geo. assistant' in 'Device' 
menu) 

40151 311 Adjustment Factor 1 - 2 ... 2 R/W Meter correction factor for customer 
adjustment of the calculated flow 
value. Can be used at installations 
where a reference meter is used to get 
reference to the true flow rate 

40196 312 Transducer cable 
length 

Product 
dependent

0 ... 200 
m 

R/W Cable length (m) from sensor to 
transmitter 

40173 372 Filter time constant Product 
dependent

0 ... 100 s R/W General time filter for flow 
measurement. Filter constant is the 
time that must pass before the filter's 
ouput value is at 70% of the change of 
its input value. Higher number gives a 
slower and more stable flow signal.  

40184 380 Protect linearization 
from user access. 

No No, Yes Read Protection of the linearization 
parameters. It is decided by the order 
number and cannot be changed. 
The linearization parameters are listed 
in the device menu 'Linearization' 

Totalizer 
40673 400 Flow direction totalizer 

1 
Forward Forward, 

Reverse, 
Net 

R/W Calculation principle on flow direction 
for forward, reverse or net flow 

40675 401 Totalizer 1 change date Last 
change 
date 

dd-mm-
yyyy; 
hh:mm:ss 

Read Date and time when totalizer 1 function 
was changed 

40674 410 Flow direction totalizer 
2 

Reverse Forward, 
Reverse, 
Net 

R/W Calculation principle on flow direction 
for forward - reverse or net flow 

40678 411 Totalizer 2 change date Last 
change 
date 

dd-mm-
yyyy; 
hh:mm:ss 

Read Date and time when totalizer 2 function 
was changed 
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Modbus 
Address 

Parameter Default 
value  

Value 
range 

Access 
level 

Description 

Pipe data 
40181 300 Number of paths Product 

dependent
2 R/W Number of paths on the sensor 

40149 302 Max sample frequency 15 15 Read The maximum frequency for flow 
measurement 

40147 303 Sample frequency 0.5 15 HW key The frequency at which the flow is 
measured 

40167 304 Rn for path 1 Product 
dependent

3.4E+38 
m 

Read R-factor for path 1. 
For FUS080/SONOKIT (retrofit) 
installations this parameter will 
automatically be calculated by the pipe 
geometric tool (see 'Pipe geo. 
assistant' in 'Device' menu). 

40169 305 Rn for path 2 Product 
dependent

3.4E+38 
m 

Read R-factor for path 2. 
For FUS080/SONOKIT (retrofit) 
installations this parameter will 
automatically be calculated by the pipe 
geometric tool (see 'Pipe geo. 
assistant' in 'Device' menu). 
Valid only for 2-path solutions 

40171 306 Inner pipe diameter Product 
dependent

0.05 ... 
1.200 m 

Read Inner pipe diameter in meters. 
For FUS080/SONOKIT (retrofit) 
installations this parameter will 
automatically be calculated by the pipe 
geometric tool (see 'Pipe geo. 
assistant' in 'Device' menu). 
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A.5 Human Interface 

Table A- 5 Human Interface parameters   

Modbus 
Address 

Parameter Default 
value 

Value range Access 
level 

Description 

40757 420 Decimal point Automatic 
point 
adjust 

No point; 
One digit 
after point; 
Two digits 
after point; 
Three digits 
after point; 
Automatic 
point adjust. 

R/W Decimal numbers for displayed 
totalized value 

40753 422 Operator Menu 1 All 1 to 5 Read 
only 

Menu setup 
1. Totalizer 1 
2. Totalizer 2 
3. Actual flow rate 
4. Error menu 
5. Display test menu 
For editing, use device menu 'Human 
Interface' 
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A.6 Unit conversion table 
The following tables show examples of totalizer and flow rate units. More are available via 
SIMATIC PDM tool 

Table A- 6 Totalizer units 

Unit Correction factor 
Default 1 m3 
m3*100 0.01 
Gallon (US) 264.1721 
G*100 (100*Gallon) 2.641721 
G*1000 (1000*Gallon) 0.2641721 
MG (1000000*Gallon) 0.0002641721 
AI (Acre Inches) 0.009728558 
AF (Acre ft) 0.0008107132 
CF*100 (100*ft3) 0.3531467 
CF*1000 (1000*ft3) 0.03531467 
I*100 (liter) 10 
kI (1000*liter) 1 
MI (Mega liter) 0.001 

 

Table A- 7 Flow rate units 

Flow rate Correction factor parameter 
Default 1 m3/s 
m3/min (m3/minute) 60 
m3/h (m3/hour) 3600 
m3/d (m3/day) 86400 
GPS (Gallon/second) 264.1721 
GPM (Gallon/minute) 15850.32 
GPH (Gallon/hour) 951019.4 
GPD (Gallon/day) 22824465 
MGPD (1000000*Gallon/day) 22.824465 
CFS (ft3/second) 35.31467 
CFM (ft3/minute) 2118.882 
CFH (ft3/hour) 127132.8 
I/s (liter/second) 1000 
I/min (liter/minute) 60000 
I/h (liter/hour) 3600000 
MI/d (1000000lLiter/day) 86.4 
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Settings B
B.1 Factory settings 

The FUS080/SONOKIT is from factory configured according to the order specification. 

For the calibration / configuration of the flowmeter the application specific pipe dimensions 
and the specific transducer locations are used.  

Table B- 1 Factory settings   

Identification  1-path factory settings (DN 
(100 to DN 1200) 

2-path factory settings DN 
(DN 200 to DN 1200) 

Possible settings  

Meter identification  - - Free text 15 characters  
Application location  - - Free text 15 characters  
Display menu Menu 1- 5 (all) Menu 1 – 5 (all) Menu 1 – 5, min one of the 

five 
Pipe data  
Number of paths 1  2  1 or 2  
Inner pipe diameter (m)  See "Dimension dependent 

settings" 
See "Dimension dependent 
settings" 

Input to pipe geometry 
program  

Transducer distance (m)  See "Dimension dependent 
settings" 

See "Dimension dependent 
settings" 

Input to pipe geometry 
program  

Distance between sound 
paths, path displacement (m) 

See "Dimension dependent 
settings" 

See "Dimension dependent 
settings" 

Input to pipe geometry 
program  

Path angle (°)  See "Dimension dependent 
settings" 

See "Dimension dependent 
settings" 

Input to pipe geometry 
program  

Q max  See "Dimension dependent 
settings" 

See "Dimension dependent 
settings" 

Adjustable  

Low flow cut-off (% of Qmax) 0.25 %  0.25 %  0 … 10%  
Fliter time constant 5 s 5 s 5 … 1000 s 
Geometry factor path 1  See "Dimension dependent 

settings" 
See "Dimension dependent 
settings" 

Auto set from pipe geometry 
help program in PDM 

Geometry factor path 2  - See "Dimension dependent 
settings" 

Auto set from pipe geometry 
help program in PDM  

Correction factor  
Costumer correction factor  1  1  0.5 … 1.5  
Measuring unit and factors  
Flow unit factor  3600  3600  Auto set from unit guide  
Totalizer volume unit factor  1  1 Auto set from unit guide  
Flow unit text  m3/h  m3/h Auto set from unit guide, but 

only m3/h can be shown on 
display 

Totalizer unit text  m3 m3 Auto set from unit guide, but 
only m3 can be shown on 
display  
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Totalizer directions  
Totalizer 1 direction  Forward  Forward  Forward/Reverse/Forward 

net/Reverse net  
Totalizer 2 direction  Reverse  Reverse  Forward/Reverse/Forward 

net/Reverse net  
Digital output 1  
Active  On  On  On/off  
Direction  Forward  Forward  Forward/Reverse/Forward 

net/Reverse net  
Amount per pulse 0.1m3  0.1 m3 Unit: The same as Totalizer 

unit 
Value freely selectable  

Pulse width  5 ms  5 ms  5, 10, 20, 50, 100, 200, 500 
ms  

Digital Output 2  
Active  On  On  On/off  
Function  Alarm  Alarm  Pulse/Alarm/Call up  
Direction  No influence, while "Alarm" No influence, while "Alarm" Forward/Reverse/Forward 

net/Reverse net  
Amount per pulse  No influence, while "Alarm" No influence, while "Alarm" Unit: The same as Totalizer 

unit 
Value freely selectable 

Pulse width  No influence, while "Alarm" No influence, while "Alarm" 5, 10, 20, 50, 100, 200, 500 
ms  

B.2 Factory settings for MODBUS communication 
 
Parameter Default setting 
Slave device address 1 
Data transmission rate 19 200 
Vertical parity position E-8-1 (0 - even) 
Response timeout 10000 ms 
Response delay 1 ms 
Interframe space 35 

The settings can be changed via SIMATIC PDM or via the MODBUS.  
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B.3 Measurement report, SONOKIT 2-path 

Sensor geometry measurement report 
 
Company Name Approved by 
Date Sensor size Pressure (PN) Tag no.: 

1A 1B

2A 2B

1B (2B)

1A (2A)

 
 
Note 
→ = Flow direction 
Measure Calculation Result 
Circumference (C) C / π = Outer diameter of the pipe (Du) Du 
Pipe wall thickness (t) Du - (2 x t) = Internal diameter (Di) Di 
Transducer distance (L) path 1 L1 = 
Transducer distance (L) path 2 L2 = 
Angle θ transducer 1A (angle 1A = 1B ; +/- 0,1º) 
Angle θ transducer 1B (angle 1A = 1B ; +/- 0,1º) 

Average angle (path 1) "(1A + 1B) / 2" 

Angle θ transducer 2A (angle 2A = 2B ; +/- 0,1º) Average angle (path 2) "(2A + 2B) / 2" 
Angle θ transducer 2B (angle 2A = 2B ; +/- 0,1º) 
Transducer separation Ha 
Transducer separation Hb 

h = (Ha + Hb) / 4 (for FUS060) and 
H = 2 x h (for FUS080) 

Cable length (distance from tranducer to converter x 2) Qmax 
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B.4 Dimension dependent settings, SONOKIT 2-path 
 
Nominal size *) 

[mm] [inch] 

Max. vol. 
flow  
[m3/h] 

Pipe  
diameter  
[m] 

Path  
displacement 
[m] 

Path 1 
angle  
[º] 

Path 1 
length  
[m] 

Path 2 
angle  
[º] 

Path 2 
length 
[m] 

DN 200 8 380 0.2083 0.0510 60 0.2257 60 0.2257 
DN 250 10 600 0.2604 0.0638 60 0.2782 60 0.2782 
DN 300 12 850 0.3098 0.0759 60 0.3279 60 0.3279 
DN 350 14 1000 0.3396 0.0832 60 0.3579 60 0.3579 
DN 400 16 1300 0.3904 0.0956 60 0.4090 60 0.4090 
DN 450 18 1700 0.4500 0.1103 60 0.4690 60 0.4690 
DN 500 20 2200 0.4920 0.1205 60 0.5113 60 0.5113 
DN 550 22 2600 0.5500 0.1348 60 0.5697 60 0.5697 
DN 600 24 3200 0.6016 0.1474 60 0.6216 60 0.6216 
DN 650 26 3600 0.6500 0.1593 60 0.6704 60 0.6704 
DN 700 28 4200 0.6952 0.1703 60 0.7159 60 0.7159 
DN 750 30 4800 0.7500 0.1838 60 0.7710 60 0.7710 
DN 800 32 5500 0.7968 0.1952 60 0.8181 60 0.8181 
DN 900 36 7500 0.9100 0.2230 60 0.9321 60 0.9321 
DN 1000 40 9000 1.0000 0.2450 60 1.0227 60 1.0227 
DN 1100 44 10000 1.1000 0.2695 60 1.1233 60 1.1233 
DN 1200 48 13200 1.2000 0.2940 60 1.2240 60 1.2240 
DN 1300 52 14000 1.3000 0.3185 60 1.3246 60 1.3246 
DN 1400 56 16800 1.4000 0.3430 60 1.4253 60 1.4253 
DN 1500 60 19000 1.5000 0.3675 60 1.5259 60 1.5259 
DN 1600 64 22800 1.6000 0.3920 60 1.6266 60 1.6266 
DN 1700 68 25000 1.7000 0.4165 60 1.7273 60 1.7273 
DN 1800 72 27600 1.8000 0.4410 60 1.8279 60 1.8279 
DN 1900 76 31000 1.9000 0.4655 60 1.9286 60 1.9286 
DN 2000 80 36000 2.0000 0.4900 60 2.0292 60 2.0292 
DN 2100 84 37000 2.1000 0.5145 60 2.1299 60 2.1299 
DN 2200 88 42000 2.2000 0.5390 60 2.2306 60 2.2306 
DN 2300 92 45000 2.3000 0.5635 60 2.3312 60 2.3312 
DN 2400 96 51000 2.4000 0.5880 60 2.4319 60 2.4319 
DN 2500 100 53000 2.5000 0.6125 60 2.5325 60 2.5325 
DN 2600 104 60000 2.6000 0.6370 60 2.6332 60 2.6332 
DN 2700 108 62000 2.7000 0.6615 60 2.7338 60 2.7338 
DN 2800 112 72000 2.8000 0.6860 60 2.8345 60 2.8345 
DN 2900 116 71000 2.9000 0.7105 60 2.9352 60 2.9352 
DN 3000 120 78000 3.0000 0.7350 60 3.0358 60 3.0358 
DN 3100 124 82000 3.1000 0.7595 60 3.1365 60 3.1365 
DN 3200 128 85000 3.2000 0.7840 60 3.2371 60 3.2371 
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Nominal size *) 

[mm] [inch] 

Path 1 
length  
[m] 

Path 2 
angle  
[º] 

Path 2 
length 
[m] 

Max. vol. 
flow  
[m3/h] 

Pipe  
diameter  
[m] 

Path  
displacement 
[m] 

Path 1 
angle  
[º] 

DN 3300 132 92000 3.3000 0.8085 60 3.3378 60 3.3378 
DN 3400 136 100000 3.4000 0.8330 60 3.4384 60 3.4384 
DN 3500 140 100000 3.5000 0.8575 60 3.5391 60 3.5391 
DN 3600 144 110000 3.6000 0.8820 60 3.6398 60 3.6398 
DN 3700 148 120000 3.7000 0.9065 60 3.7404 60 3.7404 
DN 3800 152 130000 3.8000 0.9310 60 3.8411 60 3.8411 
DN 3900 156 130000 3.9000 0.9555 60 3.9417 60 3.9417 
DN 4000 160 144000 4.0000 0.9800 60 4.0424 60 4.0424 

*) For FUS080 transmitter based systems only up to DN1200 
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B.5 Measurement report, SONOKIT 1-path 

Sensor geometry measurement report   
 
Company Name Approved by 
Date Sensor size Pressure (PN) Tag no.: 

1A 

1A 1B

1B

 
Note 
→ = Flow direction 
Measure Calculation Result 
Circumference (C) C / π = Outer diameter of the pipe (Du) Du 
Pipe wall thickness (t) Du - (2 x t) = Internal diameter (Di) Di 

L1 = Transducer distance (L) 
L2 = 

Angle θ transducer 1A (angle 1A = 1B ; +/- 0,1º) 
Angle θ transducer 1B (angle 1A = 1B ; +/- 0,1º) 

Average path angle "(1A + 1B) / 2" 

Cable length (distance from tranducer to converter x 2) Qmax 
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B.6 Dimension dependent settings, SONOKIT 1-path 

(Used dimension unit is [m]) 
 
Nominal size *) Max. vol. flow Pipe diameter Path angle  Path length  
[mm] [inch] [m3/h] [m] [º] [m] 
DN 100 4 100 0.1071 45 0.1795 
DN 125 5 150 0.1317 45 0.2143 
DN 150 6 220 0.1593 45 0.2533 
DN 200 8 380 0.2083 60 0.2584 
DN 250 10 600 0.2604 60 0.3185 
DN 300 12 850 0.3098 60 0.3756 
DN 350 14 1000 0.3396 60 0.4100 
DN 400 16 1300 0.3904 60 0.4687 
DN 450 18 1700 0.4500 60 0.5375 
DN 500 20 2200 0.4920 60 0.5860 
DN 550 22 2600 0.5500 60 0.6529 
DN 600 24 3200 0.6016 60 0.7125 
DN 650 26 3600 0.6500 60 0.7684 
DN 700 28 4200 0.6952 60 0.8206 
DN 750 30 4800 0.7500 60 0.8839 
DN 800 32 5500 0.7968 60 0.9379 
DN 900 36 7500 0.9100 60 1.0686 
DN 1000 40 9000 1.0000 60 1.1726 
DN 1100 44 10000 1.1000 60 1.2880 
DN 1200 48 13200 1.2000 60 1.4035 
DN 1300 52 14000 1.3000 60 1.5190 
DN 1400 56 16800 1.4000 60 1.6344 
DN 1500 60 19000 1.5000 60 1.7499 
DN 1600 64 22800 1.6000 60 1.8654 
DN 1700 68 25000 1.7000 60 1.9808 
DN 1800 72 27600 1.8000 60 2.0963 
DN 1900 76 31000 1.9000 60 2.2118 
DN 2000 80 36000 2.0000 60 2.3273 
DN 2100 84 37000 2.1000 60 2.4427 
DN 2200 88 42000 2.2000 60 2.5582 
DN 2300 92 45000 2.3000 60 2.6737 
DN 2400 96 51000 2.4000 60 2.7891 

*) For FUS080 transmitter based systems only up to DN1200 
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B.7 Ordering 
In order to ensure that the ordering data you are using is not outdated, the latest ordering 
data is always available on the Internet: Catalog process instrumentation 
(http://www.siemens.com/processinstrumentation/catalogs) 

http://www.siemens.com/processinstrumentation/catalogs
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P 

PDM 
Commissioning, 32 

Pressure specifications, 19 
Protective conductor terminal, 22 
Protective earth, 22 

R 

Repair, 49 
Return procedures, 53 

S 

Safety, 11 
Instrument safety standards, 11 

Sensor geometry measurement report, 87 
Service, 49, 52 

Application data sheet, 53 
Support, 52 

T 

Temperature specifications, 19 
Transit time, 17 

V 

View process values, 41 

W 

Wire insulation, 22 
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